
 

 

 

Agilent ICP Expert Software Status Bulletin 

Agilent ICP Expert Software, version 7.4.0, part number G9292-64020, G9292-64021 
and G9292-64023 

Software build number: 7.4.0, Release date: October, 2017 

This software status bulletin contains important information relating to the ICP 
Expert version 7.4.0 software. The information below highlights all issues identified 
where the software may not function according to user expectations, or according 
to other documentation, such as manuals or the Help. 

The issues listed in this document will be considered in a future release of the 
software. If you experience additional software problems not listed below, report 
them to your local Agilent representative or by e-mail to contact_us@agilent.com 

Known Issues 

General 
Problem: Changes made to some fields selected on the Options page are not saved. 

Workaround: No workaround is available. Make the changes in the worksheet to 
save them. J5760 
 

Problem: The calibrations are not saved after saving a worksheet with standard 
additions as a template with calibration. 

Workaround: No workaround is available. J5297 
 

Problem: An error message appears when exporting to Microsoft Excel during a 
run. 

Workaround: This occurs during an export when the tabular data format option is 
selected and when an excluded solution type (calibration and/or QC) is currently 
being measured. Either do not export with tabular data format, or include all 
solution types to export, or wait until the end of the analysis to export the results. 
J5134 
 

Problem: ESI autosamplers remain offline after upgrading to ICP Expert 7.3. 

Workaround: Ensure that version 2.9 or greater of the ESI software is being used. 
In addition, check that the correct ESI autosampler model is selected from the 
‘Autosampler Model’ dropdown list and that the COM port listed under ‘Connect to 
PC Port’ matches the ‘Instrument COM Port’ specified in the ESI software. For 
further information, see ICP Expert Help topic “ESI Autosamplers”. J3923 
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Problem: Results from worksheets created in ICP Expert 7.0.0 differ slightly after 
recalculating the results in that worksheet when opened in ICP Expert version 7.0.1 
or greater. 

Workaround: The precision of calculations (including Fitted background 
correction) in ICP Expert version 7.0.1 or greater have been improved from version 
ICP Expert 7.0.0. If the results from ICP Expert version 7.0.0 are required, export 
the results of the worksheet created in ICP Expert 7.0.0 before performing any 
other operations in ICP Expert 7.0.1 or greater. J3922 
 

Problem: When using the ‘New from ICP Expert II’ function, not all information is 
imported. 

Workaround: No workaround is available. This import feature will only bring over 
the method parameters. J3921 
 

Problem: Changes are not committed when using the keyboard to select items from 
drop-down menus on the tables in the Elements Page, Conditions Page and 
Sequence Page. 

Workaround: Use the mouse to select items in drop-down menus on these tables. 
J3920 
 

Problem: Very large worksheets may take a while to save or close (up to 1 minute). 
Only some actions are available while it is saving. 

Workaround: No workaround is available. J3919 
 

Problem: With multiple worksheets open, the Save button may become disabled on 
all open worksheets when one worksheet is calculating during a run or during 
recalculation. 

Workaround: Wait until the calculation is complete to save the other open 
worksheets.  J3918 
 

Problem: The Plasma button is disabled on the main ICP Expert window, but is 
enabled on the Instrument window. 

Workaround: Control the plasma from the Instrument window. Alternatively, 
restart the software or disconnect and then reconnect to the instrument to re-
enable the plasma button on the main window. J3917 
 

Problem: Unable to stop a running worksheet or shutdown ICP Expert. 

Workaround: On the ICP Expert toolbar, click Instrument > Connect and then 
deselect the connected instrument. The worksheet will stop running and ICP Expert 
can be shutdown.  J3916 
 

Problem: Starting a worksheet run while calculations are in progress in another 
worksheet locks users out of software options. 

Workaround: Wait for the worksheet to complete all calculations before starting a 
new worksheet run.  J2957 
 

Problem: Opening or closing large worksheets may suspend or affect some 
instrument actions. 

Workaround: Do not open large worksheets when the instrument is performing 
another action.  J2681 
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Problem: Some worksheet preferences selected in the Options > Preferences page 
are not applied to the worksheet. 

Workaround: Manually select the settings in your worksheet. J1995, J1997, J1996, 
J1997 
 

Problem: Opening and then immediately trying to close ICP Expert causes the 
software to crash. 

Workaround: Do not close ICP Expert while it is still starting.  J1994 
 

Problem: Copying or pasting data into a grid may not work as intended. 

Workaround: Select one cell to paste the data or use ‘Auto fill down’. J1344 

Start Page 
Problem: Recently used worksheets are not visible on the Start page. 

Workaround: Click Open or New From on the Start page or restart the software to 
refresh the list. J3860 

Applets 
Problem: Cannot open any worksheet after switching from Applet Mode to normal 
mode. 

Workaround: Reopen the software in normal mode. J5298 
 

Problem: Permissions set in the Options > ICP Applet menu may not perform as 
expected. 

Workaround: No workaround available. J3897 
 

Problem: Having two instances of the same applet open simultaneously hides the 
first instance of the worksheet. 

Workaround: Do not have two copies of the same applet open at the same time.  
J2642 

Analysis Page 
Problem: Results are truncated on the table. 

Workaround: Manually resize the columns or double-click the column separator on 
the header. J5319 
 

Problem: Duplicate columns do not display any flags. 

Workaround: This occurs after running an analysis and then creating a duplicate 
column. Add duplicate columns before running the worksheet. J5121 
 

Problem: The solution date and time displayed in a Report is different to the 
collection time displayed in the Operation log. 

Workaround: Both are correct. The time and date displayed in the Report are after 
the data processing finishes. The time and date in the Operations Log is the actual 
data collection time. Data processing times will vary depending on the worksheet 
size. J3902 
 

Problem: When running a worksheet and then selecting solutions for measurement 
above the current run position in the sequence, these solutions are not measured. 

Workaround: Stop or pause the run, select the samples to be measured and then 
start the run. J3901 
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Problem: Pump speed is incorrectly labeled as Fast Pump Speed in the Operations 
Log. 

Workaround: No workaround is available.  J3900 
 

Problem: Off-peak replicate background correction points are not overlaid in the 
Analysis page graphics window when Display Averages and Replicates is selected. 

Workaround: No workaround is available. The data points are there and included 
in the calculations, just not displayed. J3899 
 

Problem: The calibration table heading on the ‘Analysis’ page is not changed to 
‘Added Concentration’ when switching between regular calibration and 'Standard 
Additions' on the 'Standards' page. 

Workaround: Close and then reopen the worksheet. J3898 
 

Problem: Switching a wavelength that was designated as an Internal Standard to 
an Analyte with other Analytes of the same element already present does not 
update the new Analyte wavelength with any standard values which have been 
entered. 

Workaround: Display issue only. The wavelength is treated as an analyte during 
analysis.  J3013 
 

Problem: Values in the analysis grid may not display correctly. 

Workaround: Close and reopen the worksheet.  J2227 
 

Problem: When a calibration for an element is conducted using only two standards 
and the blank replicates are excluded, the Calibration coefficients are not being 
calculated when Through Blank is selected. 

Workaround: No workaround is available.  J1532 
 

Problem: When creating a duplicate column of a FACT corrected wavelength, 
‘Error’ is displayed instead of values. 

Workaround: Apply the FACT models to the duplicate row on the FACT tab.  J1230 
 

Problem: After changing the calculation method for a MultiCal column that has 
been included in a custom column equation, the MultiCal column name is not 
updated in the equation. 

Workaround: This is a display only issue. The calculations are correct. To update 
the name, delete the incorrect reference in the equation and add the new, correct 
reference.  J1119 
 

Problem: No results are displayed in the MultiCal summary and custom columns in 
the Intensity or Unadjusted Concentration views. 

Workaround: No workaround is available. Data is only available for the 
Concentration view.  J1092 

Autodilutor Page 
Problem: The autodilution factors for autocalibration standards show as "-" instead 
of the actual values in export files. 

Workaround: No workaround available. The autodilution factors are shown on the 
Sequence page in ICP Expert. J5815 
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Problem: After deselecting Recalibrate Interferents on the IEC page, the standard 
solutions are not removed on the Autodilutor page. 

Workaround: Manually remove the standard solutions not required for analysis on 
the Autodilutor page. J5805 
 

Problem: Renaming a standard in the autodilutor table is not applied to any other 
tables. 

Workaround: Manually change the name on the affected tables. J5702 
 

Problem: The autosampler position is not allocated to a stock standard on the 
Autodilutor page. 

Workaround: Confirm that the concentration is entered for that stock standard.  
J5538 

Autosampler Page 
Problem: There are unallocated QC solutions that cannot be allocated manually. 

Workaround: Increase the number of standards positions available by changing the 
rack type of a standards rack to a higher capacity rack or change the rack use from 
samples to standards. J3904 

Autosamplers 
Problem: Autosampler error messages appear upon starting the software when an 
SPS 3 is connected. 

Workaround: The default autosampler is set for the SPS 4. With the software open, 
click File > Options > General and then select the SPS 3 from the ‘Autosampler 
model’ drop-down. J3905 

Conditions Page 
Problem: The selected element spectrum is not displayed when performing a read 
on the Conditions page when using multiple condition sets. 

Workaround: Select a different element and then reselect the desired element to 
view the spectrum. J3906 
 

Problem: Intensities displayed may be incorrect after changing the background 
correction to FACT and then performing a quick read. 

Workaround: FACT background is not applied when performing a quick read. Use 
the FACT page to look at spectra with FACT background correction.  J2659 

Configuration Page 
Problem: Drift lines previously deleted in the Instrument window become available 
on the worksheet Configuration page. 

Workaround: Deselect the unnecessary drift lines on the Configuration page. J5311 

Elements Page 
Problem: When using the drop-down menu in the wavelengths column with 
languages that use the comma (,) instead of the full stop (.) to indicate a decimal, 
the wavelength is not displayed correctly. 

Workaround: Type the correct wavelength with a full stop (.) in the field or replace 
the comma (,) with a full stop in the selected wavelength. J4678 
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Problem: Unable to view some interference lines in the Interference table after 
editing a wavelength. 

Workaround: No workaround is currently available. J3908 
 

Problem: After selecting an element from the periodic table, hovering over the 
highlighted line in the available wavelengths table makes some of the information 
disappear. 

Workaround: Click on an alternative line in the available wavelengths table to 
make the information reappear. J3907 
 

Problem: An Internal Standard ratio of 1.00 is displayed in the replicates table 
even though the error message appears ‘Unable to calculate internal standard 
ratio’. This occurs if all replicates of the Internal Standard were removed in the 
first solution in an analysis and all subsequent readings of that element evaluate to 
an error. 

Workaround: No workaround is available.  J2994 
 

Problem: Changing the name of an internal standard in the Label column does not 
update the labels in the Internal Standard column. 

Workaround: No workaround is available.  J2002 

Fact Page 
Problem: When changing FACT models for a wavelength while a worksheet is 
running, results for already measured solutions are not recalculated. 

Workaround: Force a recalculation of the wavelength by making a change to the 
background correct type (for example, change to ‘Fitted’) before returning to the 
original value. It is recommended to stop any in progress worksheets before making 
changes to the FACT models.  J3425 
 

Problem: Only the elements assigned to the last run condition are read during a 
manual read. This occurs after performing a successful read without changing the 
selected elements assigned to different run conditions. 

Workaround: Reselect all elements of interest and then perform a manual read.  
J3103 
 

Problem: The FACT model graph displays a flat line starting at 0 nm. 

Workaround: Cosmetic issue only. Zoom in on the appropriate wavelength.  J2396 
 

Problem: Copying a FACT interferent model from the Library to a worksheet may 
not display the model in the worksheet FACT table. 

Workaround: Increase the number of FACT interferent models in the recipient 
worksheet until it can be seen.  J1037 
 

Problem: A FACT model from the library will only be applied to the first incidence 
of a duplicated wavelength in a worksheet. 

Workaround: No workaround is available. J1000, J2000 



Agilent ICP Expert Software Status Bulletin 

 7 

IntelliQuant 
Problem: No calibration data is generated on the IntelliQuant Analysis page after 
an analysis is run. 

Workaround: This can occur after deselecting some of the available IntelliQuant 
calibration standard solutions on the Analysis page and then attempting to run the 
analysis. Always select all calibration standard solutions to perform an IntelliQuant 
analysis. J5873 
 

Problem: ICP Expert crashes if more than one instance of the IntelliQuant Smart 
View window (accessed from the Edit button on the IntelliQuant Analysis page) is 
open or if the worksheet is closed while the IntelliQuant Smart View window is 
open. 

Workaround: Restart ICP Expert. Always close the IntelliQuant Smart View 
window before opening another instance of this window or before closing the 
worksheet. J5864 
 

Problem: Saving an IntelliQuant worksheet crashes ICP Expert software. 

Workaround: This occurs when the user does not have 'Write' privileges to the 
IntelliQuant cabinet. Before saving IntelliQuant worksheets, ensure you have 
'Read/Write' privileges for the cabinet location. J5831 
 

Problem: IntelliQuant calibration solution results are not displayed in the 
IntelliQuant Analysis grid. 

Workaround: This is a display issue only. Save, close and then reopen the 
worksheet to see the data. J5807 
 

Problem: The IQ calibration is not updated after rerunning the calibration on the 
Analysis Page. 

Workaround: Recreate the worksheet and run the calibration. J5553 
 

Problem: The values in the results and the periodic tables on the IntelliQuant 
Analysis page do not refresh after selecting a different calibration on the 
IntelliQuant Setup page. 

Workaround: Select a different solution on the IntelliQuant Analysis page to 
refresh the periodic table. There is no workaround available to refresh the results 
in the results table. This is a display issue only and the calculated concentrations in 
the results table are correct. J4960 
 

Problem: Importing worksheets into an IntelliQuant cabinet resets the date and 
time of a calibration. This occurs if the imported calibration is already present in 
the selected cabinet, for example, the supplied calibrations cabinet. 

Workaround: No workaround is available. The best practice is to always export the 
calibration block worksheet along with the desired worksheet and then import both 
into the destination IntelliQuant cabinet. It will then be possible to edit the 
calibration for the imported IntelliQuant worksheet.  J3435 
 

Problem: The graphs and charts are not displayed on the IntelliQuant Analysis 
page. 

Workaround: IntelliQuant requires a PC that supports Hardware Graphics 
Acceleration.  J2632 
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Instrument Window 
Problem: Stopping the Advanced Valve System Test crashes ICP Expert software. 

Workaround: Click Stop from the worksheet, not on the Instrument window to stop 
the test. J5824 
 

Problem: The passing limit range is not displayed on the Nebulizer test when using 
the Conikal or OneNeb nebulizer. 

Workaround: This is a display issue only. The test still performs correctly. No 
workaround is available. J5773 
 

Problem: The plasma ignition cannot be aborted during the Instrument 
Performance or Optics Test. 

Workaround: No workaround available. Stop the test and click Plasma Off on the 
ribbon bar. J5763 
 

Problem: Unable to type in the IsoMist temperature field on the Instrument page. 

Workaround: Use the arrows next to the field to change the values. J5335 
 

Problem: The ‘Plasma on’ button is still available on the main ICP Expert software 
window when performing a Detector calibration. 

Workaround: Do not turn on the plasma while performing a Detector calibration.  
J2987 
 

Problem: Camera test fails when completing the condensation removal cycle. 

Workaround: Repeat the test once the condensation removal cycle is complete. 
J2592 
 

Problem: Error messages appear after extinguishing the plasma during plasma 
ignition. 

Workaround: Close the error message window and wait for the process to 
complete.  J2587 
 

Problem: The plasma button is greyed out. All LEDs and the instrument image 
indicate no faults. 

Workaround: Turn off and on the ICP-OES.  J2487 

Sequence Page 
Problem: All sample paired QC solutions of the same type in rate generated QC 
blocks have the same ID number. 

Workaround: Do not add sample paired QC solutions to a rate generated block. 
J5762 
 

Problem: Cannot copy/paste data into multiple cells in the MDD column in the 
Sequence table. 

Workaround: Copy/paste data into one cell at a time or use Auto fill down to 
populate the cells. J5581 
 

Problem: ICP Expert crashes when adding multiple copies of the same QC solution 
into a rate block. 

Workaround: Do not use multiple copies of the same QC solution in the same rate 
block. J4808 
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Problem: ICP Expert may crash when adding a solution to a QC block. 

Workaround: Delete the QC block and re-add it with all QC solutions selected. 
J4696 
 

Problem: A QC error action is not activated if a wavelength is 'uncal'. 

Workaround: No workaround is available. J4626 
 

Problem: The sequence is incorrect after adding extra samples to a paused analysis 
with rate generated QC included. 

Workaround: Stop the worksheet to add extra samples. J3913 
 

Problem: ICP Expert may crash when adding a solution to a QC block. 

Workaround: Delete the QC block and re-add it with all QC solutions selected. 
J3912 
 

Problem: QC solutions with the same name are indistinguishable in the Rate QC 
Preferences dialog box. You can add multiple instances of the QC with the 
duplicated name in the same QC block. The name does not disappear from the list 
after selecting it. 

Workaround: Use unique names for QC solutions. J3911 
 

Problem: When adding a Lab Control Sample into the samples table on the 
Sequence page, the solution is added to the standards rack instead of the samples 
rack. 

Workaround: Manually change the position of the solution on the autosampler rack 
using the drop-down Rack/Tube menu. J3910 
 

Problem: The expand/collapse buttons for calibration and QC blocks on the 
Sequence page can be unpredictable upon closing and opening of a worksheet. 

Workaround: Expand or collapse blocks as required. J3909 
 

Problem: Adding a rate QC block and using the ‘Insert solution below’ function will 
insert the selected QC test solution above the QC block. 

Workaround: No workaround is available. J3006 
 

Problem: Renaming a QC solution after it has been added to the sequence doesn't 
rename the solution in the sequence. This also occurs on the Analysis page. 

Workaround: Cosmetic only. Double-click on the cell to refresh the name.  J2873 
 

Problem: Re-inserting a solution after deleting it previously puts it in the wrong 
position. This occurs when trying to insert a solution between a calibration and a 
QC block. 

Workaround: Save the worksheet, close it and reopen it. The solution is now in the 
correct position.  J2779 
 

Problem: Unable to change the rate of a QC rate block. This occurs after the 
sequence has becomes invalid. 

Workaround: Delete the QC rate block and then re-add it.  J2658 
 

Problem: The ‘Up’ and ‘Down’ arrows are not available in the QC rate preferences 
dialog box. 

Workaround: Select a different sample and then reselect the desired sample.  J2458 
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Problem: Increasing sample count during a run does not increment the sample 
count correctly. 

Workaround: No workaround currently available.  J2307 
 

Problem: Unable to insert rate generated QC blocks after manually stopping a run 
and then deleting results from a worksheet. 

Workaround: Close and reopen the worksheet.  J2164 
 

Problem: In some circumstances, adding samples or QC samples to the existing list 
on the Sequence page incorrectly increments the sample number or location on the 
autosampler rack. 

Workaround: Manually renumber and review the sequence.  J2020 
 

Problem: Adding a sample related QC to a rate QC block and then changing the rate 
incorrectly renames the QC labels within the rate QC block. 

Workaround: Delete the QC block and re-add it with all QC solutions selected.  
J2018 

Standards Page 
Problem: Multiple zeros are defined in the calibration table for one wavelength. 

Workaround: Manually change the calibration concentration so that there is only 
one zero point specified per wavelength. J5585 
 

Problem: Rack:Tube positions are missing or incorrect on tables on the Standards 
or Autodilution page. 

Workaround: Rack:Tube positions on the Sequence page are correct and can be 
modified if required. J5554 
 

Problem: Blank concentration cells on the Standards page are empty. 

Workaround: This occurs when opening a worksheet from a template that 
originally included multiple blanks. The 'Include blank' checkbox is then selected. 
This is a display only issue, the results are calculated with a zero concentration 
blank. No workaround is available.  J5080 
 

Problem: Switching to or from ‘Standard additions’ or toggling the reagent blank 
deletes any existing defined concentration values 

Workaround: No workaround currently available. Re-enter the defined 
concentrations on the ‘Standards’ page. J4604 
 

Problem: When changing the calibration mode, a second action of Weighted Fit or 
Through blank may be ignored if it is still recalculating. This may result in data not 
being modified as expected. 

Workaround: Select another parameter to trigger a recalculation and then reselect 
Weighted Fit or Through blank. J3914 
 

Problem: When a cell is selected in the MultiCal table the maximum concentration 
does not update when changing the maximum concentration in the Standards table. 

Workaround: Manually edit the value in the cell.  J1122 
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Communication 
Problem: When connecting ICP Expert software to the ICP-OES, connecting to the 
instrument with a ‘.local’ address does not work. 

Workaround: Ensure the ‘Bonjour’ service is installed and running. To do this: 1 
Press CTRL, ALT and DEL on the keyboard at the same time. 2 Select Start Task 
Manager. 3 Select the Services tab. 4 Look for Bonjour Service in the list. 5 If the 
service is not running, right-click it and then select Start Process.  6 If the service is 
not present, re-install Bonjour64 Windows Installer Package located on the ICP 
Expert software installation CD.  J3924 

During Analysis 
Problem: The ESI autosampler probe is going to the wrong standards tube or 
hitting the standards tube rack during analysis. 

Workaround: This can occur if the ESI standards rack is correctly selected in ICP 
Expert software but is not selected in the ESI SC software. Select the correct 
standards rack in both the ICP Expert software and the ESI SC software. J5853 
 

Problem: Worksheets with Custom Replicates selected in File > Options when using 
ICP Expert Base mode cannot be run. 

Workaround: Custom replicates is an ICP Expert Pro feature only. Open ICP 
Expert in Demo mode, deselect Custom Replicates in the Configuration page, close 
ICP Expert Demo mode, and then open the worksheet in ICP Expert. J5820 
 

Problem: Samples are skipped during analysis. 

Workaround: This occurs when using the autodilutor and have added rate QC 
blocks with 'stop' as the selected error action. Either do not use 'stop' as the error 
action or manually stop the worksheet, reselect the missing samples, and then start 
the analysis. J5814 
 

Problem: The sample paired rate QC refers to the added reactive autodilution 
sample instead of the correct sample. 

Workaround: This occurs when sample paired QC solutions are included in rate QC 
blocks at the end of the sequence. No workaround is available. J5758 
 

Problem: Rerunning any sample paired to a QC solution after its paired QC does 
not update the results for the paired QC solution. 

Workaround: Always run your QC solutions in the correct order. J5508 
 

Problem: A mismatch error appears when attempting to run a worksheet created 
from a template from ICP Expert 7.3 with the AVS checkbox selected. 

Workaround: This occurs when the Autosampler checkbox is not selected but the 
worksheet had AVS selected. Enable the Autosampler on the Configuration page 
and then disable the AVS. J5358 
 

Problem: Solutions on the Analysis page are showing as remeasured even though 
they have not been previously run. 

Workaround: This occurs when the worksheet is saved without any elements added 
on the Elements page and then reopened. Elements are then added and then the 
analysis is run. Always save worksheets with at least one element selected. J5323 
 

Problem: The correlation coefficient is always 1 when Force Through 'Origin' is 
selected on the interferent calibration. 

Workaround: No workaround is available. J5078 
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Problem: End of run actions only apply to the last worksheet in a batch, not the 
previous worksheets. 

Workaround: No workaround is available. J5049 
 

Problem: Microsoft Windows reports that the SPS 4 USB device has malfunctioned. 

Workaround: Check the USB cable. Restart the Agilent SPS 4 Autosampler and 
then restart the computer. J4862 
 

Problem: A measurement is performed before the new conditions have been 
stabilized.This occurs when using multiple condition sets and when the uptake and 
stabilization times are set to zero or lower than the time it takes for the first 
condition set of each sample to be applied. 

Workaround: Always set the uptake and stabilization times to a minimum of 5 
seconds combined when running with multiple condition sets. J4847 
 

Problem: Sample is incorrectly labeled as 'Remeasured' if the analysis is stopped 
before any measurements occur for the first replicate of a sample. 

Workaround: Do not stop the analysis before the first replicate of the sample has 
been read. J4796 
 

Problem: ICP Expert software becomes slow or unresponsive. 

Workaround: Restart the software. J3927 
 

Problem: Under certain conditions, running a worksheet with two condition sets 
(axial and radial), the error messages 'Instrument Command Failed' and 'Run could 
not proceed’ appear during the analysis. 

Workaround: Dismiss the errors and then click ‘Run’ to restart the analysis. J3926 
 

Problem: When using drift correction, a wavelength shift might be observed if the 
plasma is extinguished and then reignited. 

Workaround: Do not turn plasma off during a worksheet run. J3925 
 

Problem: An error message “NEXUS_T_ABNORMAL_PROCESS_TERMINATION” 
appears during the analysis where drift correction is enabled. The worksheet run is 
stopped. 

Workaround: Restart the instrument J3072 
 

Problem: The error message ‘Rational curve unsuitable’ error applied to failed 
quadratic curves. 

Workaround: Re-enter the standard concentrations and then recalculate. See the 
ICP Expert Help for more information about quadratic curves.  J3029 
 

Problem: The graphics windows are replaced with red ‘x’s after extremely long 
analysis. 

Workaround: This is a display issue only, the results are not affected. Restart the 
software to graphically display the results.  J2714 
 

Problem: Reprocess time is slow on large worksheets with a large number of 
recalibration blocks. 

Workaround: Reduce the number of recalibration blocks.  J2692 
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Problem: Unable to run worksheets with drift correction enabled. This occurs when 
running a worksheet with drift correction enabled and the software crashes, is 
closed, or the drift measurement status persists and cannot be stopped. 

Workaround: Using a worksheet without drift correction enabled, perform a 
conditions read or run a sample. Then run the worksheet with drift correction 
enabled.  J1970, J2990 
 

Problem: Unexpected QC error action behavior occurs when using MultiCal with 
the same wavelength. 

Workaround: No workaround is available.  J1117 

Report Designer 
Problem: The item list in the Worksheet Items section is incorrect. This occurs after 
switching from Report Designer to the ICP Expert software, clicking File > Report > 
Report Preview in ICP Expert and then switching back to Report Designer. 

Workaround: Close Report Designer and then reopen it. J3929 
 

Problem: After closing the software when the Report Designer has been in use, an 
error message will appear. 

Workaround: There is no workaround. This does not affect any templates created 
or reports generated. J3928 
 

Problem: Hidden columns at the start or end of a selection are not getting reported 
when ‘Report all highlighted columns’ is selected. 

Workaround: Unhide all columns and then select the desired cells to report.  J2771 
 

Problem: After changing the font on selected items the preview window is blank 
and a PDF cannot be generated. 

Workaround: Select the default font.  J1309 

Reports 
Problem: ICP Expert software crashes when using the software while trying to 
create a report. 

Workaround: No workaround available. J5362 
 

Problem: Reports with recalibration or reslope blocks are not labeled correctly. 

Workaround: No workaround is available. The calibration graphs are shown in the 
order in which they were run. J5157 
 

Problem: The detection limit table appears in the report when no QC solutions 
selected use the MDL or CRQL limits. 

Workaround: Deselect the 'Detection Limit' table under QC setup in Report 
Designer to remove the table from the report. Save the report template as another 
name to ensure the existing template is not altered. J5027 
 

Problem: Results for unfinished measurements are included in the exported report. 

Workaround: No workaround is available.  J4885 
 

Problem: Method setup parameters and data are missing after opening reports 
generated from worksheets migrated from previous software versions. 

Workaround: Customize the report by selecting the appropriate options in the 
Reporting Options menu.  J2287 
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Localized Software Issues 
Problem: When registering the software on Japanese language installations, 
entered text moves to the next field. 

Workaround: Press Enter to commit the changes before moving to the next field. 
J3893 

ICP Expert with 21 CFR 11 Enabled 
While the problem/workarounds listed in this section, the SDA and SCM sections 
are specific only to ICP Expert with 21 CFR 11 enabled, the problems listed in other 
sections also apply to this software version. 

 

Problem: The worksheet cannot be saved after opening after ICP Expert crashed or 
was forced to quit. 

Workaround: Open SDA. Click the Viewer tab. Navigate to the location where the 
worksheet is saved in the database, right-click on the worksheet and then select 
Unlock Workspace. Open the worksheet in ICP Expert and then save. J5818 
 

Problem: Changes made to the software are attributed to the next user to unlock 
the software. 

Workaround: No workaround is available. Always save changes before leaving the 
computer. J5730 
 

Problem: Saving a worksheet fails. The worksheet file becomes corrupted and 
unusable. This occurs when two unsaved worksheets are open, and then one is 
closed without saving it. Saving the remaining open worksheet will fail. 

Workaround: No workaround is available. No data is lost. With the appropriate 
permissions, it is possible to delete the file when logged in to SDA software. J4882 
 

Problem: Worksheets created from a fully approved template are locked. 

Workaround: To create an unlocked worksheet, open and save the locked template 
as a new template. Create a  worksheet from this new, unlocked template by 
selecting File and then New From Template. J4792 
 

Problem: Date formats are different in the audit trail. 

Workaround: Date entries are based on the Microsoft Windows calendar settings. If 
the calendar settings are changed, some of the date entries will reflect this change. 
The audit trail entry headers will always be in the current date format and will 
always be correct relative to each other. J4780 
 

Problem: If the CFR timeout lock is applied when unsaved changes are present, the 
changes are attributed to the next user to unlock and save the worksheet. 

Workaround: No workaround is available. Always save changes before leaving the 
computer. J4742 
 

Problem: The off-peak marker positions are not logged in the Audit Trail after 
changing the background correction mode and then saving the change. 

Workaround: Move the peak marker, save the worksheet and then change the 
background correction mode. J4627 
 

Problem: It is not possible to remove IEC results in a template after data has been 
collected when 21 CFR 11 is enabled. 

Workaround: Create a new worksheet and then save as a template before collecting 
data. J4623 
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Problem: Changing the order of QC solutions in a rate block does not get logged in 
the CFR audit trail if those solutions are present elsewhere in the sequence. 

Workaround: Remove the rate QC block, save the worksheet and then re-add it. 
J4609 
 

Problem: In ICP Expert with 21 CFR 11, if the file becomes locked certain 
operations (save, collect more data) will report errors. 

Workaround: Unlock the file in Spectroscopy Database Administrator (SDA) before 
performing those operations. J3932 
 

Problem: In ICP Expert with 21 CFR 11, the select for measurement checkbox on 
the Analysis page occasionally will not be deselected after a measurement is 
performed. 

Workaround: This is a graphic display issue only. The solutions cannot be 
remeasured. J3931 
 

Problem: In ICP Expert with 21 CFR 11, the results editing privilege does not allow 
the following to be updated pre/post run:  

 Detections limits  

 CCV, CRS, ICSA, ICSAB, ICV, LCS, MSPK, QCSPK - defined concentration, 
lower limit and upper limit  

 DUP, SER - Difference  

 Editing QC equations 

Workaround: Currently the worksheet editing privilege allows these parameters to 
be edited.  J3930 
 

Problem: Signature is required for IEC factor calculations after analysis has been 
completed. 

Workaround: No workaround is available.  J3303 
 

Problem: Signature is required for a rack/tube allocation change after each 
worksheet save. 

Workaround: No workaround is available.  J3299 
 

Problem: The filename displayed on the open worksheet tab is truncated. This 
occurs when the filename has a full stop “.” in it. 

Workaround: No workaround is available.  J2821 
 

Problem: An error message appears when attempting to save a duplicate copy of an 
open worksheet. 

Workaround: Do not open more than one copy of a worksheet at the same time.  
J2820 
 

Problem: The software crashes when trying to save a worksheet to a subfolder that 
was identified as the default project path in SCM. 

Workaround: Do not define a subfolder as the default project path in SCM. J2818 
 

Problem: Importing a .CSV file using the ‘Import from LIMS’ function allows all 
users to import sample name, dilution factor and sample weight values, regardless 
of whether their privileges allow for Sequence Editing or not. 

Workaround: No workaround available. The ‘Import from LIMS’ function can only 
be used on new worksheets.  J1527
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Spectroscopy Configuration Manager (SCM) 
Problem: The 5100 and 5110 ICP-OES privileges table in the SCM Help is missing 
content. 

Workaround: The ICP Expert Privileges table accessed through the SCM Help is not 
the latest version. The current version of the Privileges table (file name 
ICPExpert_7_4_CFR_Privileges) is located on the ICP Expert software installation 
disk.Changes include adding the Expanded QC privileges and the Peak Marker 
privilege to the Analysis section of the table. J4740 
 

Problem: User is unable to change their own password, even after getting assigned 
the ability to change their password. 

Workaround: There is no workaround available. Administrators must change the 
password. J4717 
 

Problem: Unable to log in to SCM after a user changes the password length to zero. 

Workaround: There is no workaround. Do not set the password length to zero. SCM 
must be reinstalled and privileges and profiles reconfigured. It is recommended 
that SCM is set up with more than one Administrator. J4653 
 

Problem: The changes are not applied after altering one of the stored reasons for 
change. 

Workaround: Restart the SCM software. J4641 

Spectroscopy Database Administrator (SDA) 
Problem: An error occurs after performing multiple database operations in SDA. 

Workaround: Exit SDA and then restart. J3935 
 

Problem: Supplied databases are not automatically attached during installation. 

Workaround: Manually attach the databases in SDA. J3934 
 

Problem: When running SDA, toggling between Advanced Setup and then 
Simplified Setup greys out all of the menu items under Database Maintenance. 

Workaround: Click Advanced to access those features. J3933 

To report any undocumented software problems or to suggest improvements to the 
software, contact your local Agilent representative or e-mail: 
contact_us@agilent.com 
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